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1. YOUR TUNES EXPLORER WIRELESS

Congratulations on your purchase! Tunes Explorer Wireless gives you the freedom to access the
entire music collection on your computer remotely. Browse through and enjoy your iTunes library,
playlists, podcasts and Infemet radio stations from another room: it's never been so easy fo
navigate through your music and enjoy your collection without being chained to your computer,

Using Tunes Explorer Wireless is safe: there's no danger of your songs being deleted or altered
accidentally. Imagine the fun you'll have at parbies when all of your friends can fake fums looking
through your music collection, selecting their favarites and playing DJ for a while! The music plays
over your computer's sound card and speakers for everyone 10 enjoy.

Share your music and listen to the songs you want, when you want, where you want: if's all
possible with Tunes Explorer Wireless.

1.1. Recommended use
- Never open up Tunes Explorer Wireless, as you risk damaging its intemal components,
- To ensure optimal use of Tunes Explorer Wireless, keep it away from:
- rain or humidity, as well as all fluids (water, chemical products or any other liquids),

- heat sources such as radiators, stoves or any other heat-producing appliances
(including amplifiers).

- direct sunhght.

- Clean Tunes Explorer Wireless with a damp cloth and avoid the use of aerosol cleaners.

1.2. Specifications

»  Pocket-size remote control for iTunes: 4*17 x 2°4 x 0°68 (10.6 x 6 x 1.7cm)
=  Powered by 2 AAA batteries (not included)

=  Radio Frequency transmission {up to 90 feet range, non-directional use)

=  Embedded LCD screen to display menus and music fifles

= Blue backlight for LCD screen (useable anywhere)

»  Lateral scroll + click whee! (for quick browsing through large audie libraries)
»  USB full-speed receiver (PC and Mac compatible)

=  Confrols all music supported by iTunes (audio files, podcasts and Intemet radio
stations), including DRM-protecied files



1.3.  Minimum system requirements (PC)

= Microsoft Windows XP Home Edition/Professional Edition
= |ntel Pentium Il or AMD Athlon 500MHz processor

= 256MB RAM (512MB recommended)

= Sound card

= CD-ROM drive

= USB2.0orUSB1.1 port

1.4. Minimum system requirements (Mac)
= MacOSX104

= 400MHz G3 /G4 / G5/ Intel processor

= 256MB RAM (512MB recommended)

=  CD-ROM drive

= USB2.0orUSB1.1 port

1.5. Box contents

»  Hercules Tunes Explorer Wireless remote control
= USB dongle Radio Frequency transmitter

= Semi-rigid USB directional cable

= [nstallation CD-ROM containing Hercules software, Apple iTunes and QuickTime
software and user manual in PDF format



2. SETTING UP TUNES EXPLORER WIRELESS
2.1, Installing the software (Windows XP)

- Insert the CD-ROM provided into your CD-ROM drive.

The installation assistant appears automatically.

& If the installation menu does not launch automatically:
- Double-click My Computer.

- Double-click the CD-ROM icon.

- Double-click Setup.exe, if necessary.

- Follow the on-screen instructions to launch installation of the Tunes Explorer Wireless software
as well as Apple iTunes and QuickTime, if recent versions these last two applications are not
already Installed on your system.

Once installation is complete, the 2 joon appears in the system tray in the bottom right-hand
corner of your screen.

2.2. Installing the software (Mac OS X)
- Insert the CD-ROM provided into your CD-ROM drive.
The installation CD-ROM appears on your desktop.
- Double click the CD-ROM icon and navigate to the installer package.

- Double-click the installer package and follow the on-screen instructions to launch installation of
the Tunes Explorer Wireless software as well as Apple iTunes and QuickTime, if recent versions
these last two applications are not already installed on your system.

You may be prompted to restart your computer once installation is complete.



2.3. Installing the USB dongle

- Connect the USB dongle to a USB port on your PC or Mac. You can attach it to the semi-rigid
directional cable (included) if that makes it easier to connect to your computer.

Windows XP displays a Found New Hardware message in the system tray in the hottom right-
hand comer of your screen. Windows automatically installs the required Windows drivers and then
displays a message indicating that the hardware is ready fo use.

24. Installing batteries in Tunes Wireless Explorer

Open up the battery compartment at the back of your Tunes Wireless Explorer and insert 2 AAA
batteries (not included). Close the battery compartment again when you're done.

2.5. Connecting Tunes Explorer Wireless to your computer

& When establishing a connection between the Tunes Explorer Wireless remote and your
computer for the first time (or after having replaced the batteries), you must keep the remote
very close to the USB dongle (no more than a few inches away) when connecting it to your
computer.

- Press and hold the Select button on the remote for 2 seconds.
The screen on the remote lights up and displays the message: “Loading ITunes... Please wat...".

- Wait while ITunes Is launched and minimized on your computer.

2.6. Speakers

In order to hear the music being played on your computer's sound card, you need to have
speakers connected or integrated speakers in your laptop or monitor, for example. Make sure that
your speakers are properly connected and adjust the volume to a comfortable listening level.
Finally, ensure that the volume at the top of your ITunes screen is set to an appropriate level.



3. OVERVIEW
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3.1. Button functions

Volume downlup: Press or hold down either of these buttons fo decrease or increase the volume,
respectively.

Press both the volume up and down buttons simultaneously to mute/un-mute.

Menu: Press to retum to the previous menu.

Back/Forward: Press once to skip to the previous or next track. Press and hold to rewind or fast
forward within a song. These buttons are always active.

Select: In play screen mode, press Select to move back and forth to the Rating screen (use the
scroll wheel for your rating and click the wheel or press Select to apply the rating).

In list mode, press Select to select an object in the list (clicking the scroll wheel has the same
function).

Play/Pause: Press to play or pause a track. This button is always active.

Press and hold the Play/Pause button for a few seconds to put the remote info slkeep mode. Press
any button fo wake it up.

Navigation

Standard navigation

Scroll + click wheel: Use the wheel 1o scroll up and down through lists and click the wheel
10 sekecl,

Use the scroll wheel to assign ratings to your songs in the Rating screen and click the
wheel or press Select to apply the rating.

Fast navigation

Press and hold the Menu button while turning the scroll wheel to “jump” through any list.
The bigger the list, the further you will jump at a time, allowing you 1o move through even
large lists very quickly.

Hold switch: Set the hold switch to Lock to immobilize all buttons (including the scroll wheel) on
the remote. Set the switch 1o Unlock to restore button functions.

& If the remote is off with the hold switch set to lock, you must unlock the hold switch to
turn the remote back on again.



4. THE MAIN MENU

Serolling through the main menu on your Tunes Explorer Wireless displays the following headings:
Library, Playlists, Party Shuffle, Podcasts, Radio, Play Screen, Settings and Resync with
iTunes.

This manual assumes that you have a working knowledge of the iTunes software. If you are new
to iTunes, it would be helpful to have a look through the extensive iTunes help file (the Help menu
at the top of your iTunes screen) for all the information you need on how the software works.

We will now go through each of these headings on the main screen, as well as their sub-headings,
to give you an idea of how to use your Tunes Explorer Wireless remote to control and listen to the
music in your iTunes music library.

& When you make changes to items in your iTunes library (new songs added, new
playlists created, efc.), you must resynchronize Tunes Explorer Wireless with iTunes in order
for those changes to be reflected on your Tunes Explorer Wireless screen.

41. Library

This heading allows you to access all of the music in your iTunes library. Clicking Library in the
main menu screen brings you to a sub-menu with the following categories:

- Artists: Click to access a list of all the artists in your iTunes music library in alphabetical order.
- Albums: Click to access a list of all the albums in your iTunes music library in alphabetical order.

- Genres: Click to access a list of all the genres in your iTunes music library in alphabetical order.
Genres are categories used to classify your music: Rock, Pop or Classical, for example.
Selecting All in the genres category will bring you to a list of all artists in all genres in your music
library. Selecting a single genre in the list (Rock, for example) will bring you to a list of artists in
that genre.

- Rating: Click to access a list of all rated songs in your library: Rating: 5, Rating: 4. efc.
Selecting Rating: 5, for example, will then display all songs with a rating of 5, and so on.
Selecting All will display all songs with ratings assigned.

- Songs: Click to access a list of all the songs in your iTunes music library in alphabetical order,



4.2. Playlists
Playlists are lists of songs or other items in your iTunes music library (podcasts, for example).

=
Some playlists are dynamic or “smart” playlists, represented by the purple icon to the left of
the playlist in iTunes. Dynamic playlists are referred to as smar playlists because they update
automatically according to criteria that have been defined for them. Default smart playlists in
ITunes include Recently Added. Recently Played and Top 25 Most Played: these include songs
recently added to your iTunes library, songs you have recently played and songs you have played
the most, respectively.

You can nght-click a smart playlist in the Source list on the left-hand side of your screen in iTunes
and select Edit Smart Playlist to view the rules that have been defined for that playlist and edit
them, if you wish; in your Recently Added smart playlist, you may decide to change the default
value of songs added to your library within the last 2 weeks to within the last 4 weeks, for example.

To create a new smart playlist in iTunes, click the File menu at the top of your iTunes screen and
then New Smart Playlist.... You can then define the settings for that smart playlist in the dialog
box that appears. When you're done, name your playlist,

-
Other playlists are standard playlists, represented by the light blue 'Lﬂ icon to the left of the
playlist in iTunes. Standard playlists are playlists that you add to manually by dragging and
dropping songs or podcasts from your iTunes library onto the playlist in the Source list on the lefi-
hand side of your iTunes screen. You might want to choose some songs from a few of your
favorite rock bands, for example, or select a bunch of mellow songs to set the mood at a dinner
party.

To create a new playlist in iTunes, click the File menu at the top of your iTunes screen and then
New Playlist.... You can then drag and drop songs or podcasts from your library onto the playlist
on the left-hand side of your iTunes screen to create the perfect talor-made mix, When you're
done, name your playlist.

4.3. Party Shuffle

Party Shuffle creates a dynamic playlist made up of a random selection of songs from your library
or any playlist you choose, a sort of “live mix”. To view and make changes to the Party Shuffle list;

- Click Party Shuffle in the list on the left-hand side of your iTunes screen.

- Select a source from which to create the mix in the Source: pop-up list at the bottom of the
screen (your entire library or a playlist of your choice).



- Select the number of played or upcoming songs to be displayed in the playlist.

To change the list of upcoming tracks, click the Refresh button in the top right comer of the iTunes
window. If you've added any songs manually, they will remain in the list.

4.4. Podcasts

Podcasts are shows — either audio or video — that you can download to your computer using
ITunes. You can either download podcast episodes individually or subscribe to a podcast so that
you receive the latest installments automatically.

Podcasts are not the same as Intemet radio stations: Internet radio stations are streamed over the
Internet, whereas podcasts are actually downloaded to your computer before they can be played.

To download or subscribe to podcasts, click Podcasts in the Source list on the left-hand side of
your screen in iTunes, then click Podcast Directory at the bottom of your screen.

& You must drag and drop podcasts into your music library in iTunes for them to be
accessible via your Tunes Explorer Wireless. You should also remember to resync Tunes
Explorer Wireless with iTunes after adding new elements to your library so that you can view
them on your remote.

4.5. Radio

Internet radio stations are streamed over the Internet to your computer, meaning that you don't
have to download them before listening. There are a huge number of Intemet radio stations
available to cater to every listening taste, with more added every day.

To browse through Internet radio stations, click Radio in the Source list on the left-hand side of
your screen in iTunes. You can then select a radio category and look through all of the various
stations available.

A You must drag and drop radio stations into your music library in iTunes for them to be
accessible via your Tunes Explorer Wireless. You should also remember to resync Tunes
Explorer Wireless with iTunes after adding new elements to your library so that you can view
them on your remote.



4.6. Play Screen

The Play Screen is the screen that is displayed on your remote when something is playing in
iTunes. Information about the song and the elapsed time are displayed on your Tunes Explorer
Wireless screen.

In play screen mode, press the Select button to move back and forth to the Rating screen (use the
scroll wheel for your rating and click the wheel or press Select to apply the rating).

If a song is paused and the remote goes to sleep, it will not display the play screen when it wakes
up again.

4.7. Settings

Via the Settings menu you can access a variety of parameters relating to playback, EQ controls
and performance of your Tunes Explorer Wireless.

4.7.1. Play Mode
- Select how tracks are played: Repeat Once, Play All Once, Shuffle, Repeat or Shuffle Repeat,

A As these options relate to playlists or your library, any changes you wish to apply must
be made before selecting the playlist or library in question.

4.7.2. Video Mode

- 1ITunes offers a Visualizer window which displays visual effects to go along with music you are
listening to. There are two options here, Hidden and Visualizer: the first hides the iTunes
visualizer, while the second displays .

4.7.3. Equalizer

- The equalizer setting is set to Flat by default. Use this option to select from a list of available EQ
seftings to change the way your music sounds, including Disable, Manual, Acoustic, Bass
Booster and more. Please note that there is no display of graphics equalizer on the remote.



4.7.4. RF freq. state

- This sefting displays information about the status of RF frequency transmission for your Tunes
Explorer Wireless.

4.7.5. Set LCD backlight

- This setting allows you to adjust the intensity of the blue backlight on your Tunes Explorer
Wireless screen: Off, Low intensity, High intensity or Medium intensity (the default sefting).

4.8. Resync with iTunes

Use this option to resynchronize Tunes Explorer Wireless with your iTunes library.

& Remember to resync Tunes Explorer Wireless with iTunes after adding new elements o
your library so that you can view them on your remote.



5. FAQ

- The remote can’t seem to make a connection with the USB dongle.

When first using the Tunes Explorer Wireless remote (or after having replaced the batteries), it is
important for the remote to be very close to the USB dongle connected to your computer (no more
than a few inches away) in order for it to be initialized and identified correctly.

-1 get the message “No Host Available” when trying to connect.

This message indicates that the remote cannot communicate with the computer because the
Tunes Explorer Wireless application is not running. Make sure that that Tunes Explorer Wireless
application Is running on your computer and then try again.

In Windows XP, the Tunes Explorer Wireless icon =4 should be present in the Windows system
tray in the bottom right-hand comer of your screen.

- How can | find out which track is currently playing?
To display the track currently playing, select Play Screen from the main menu.

- None of the buttons on the remote seem to be active / | can’t bring the remote out of sleep
mode.

Make sure that the batteries are inserted correctly and fully charged. Also verify that the hold
switch is not set to the LOCK position.

- Can | add items to playlists or create new playlists using the Tunes Explorer Wireless
remote?

No, you can't add items to playlists or create new playlists using the remote. These changes must
be made on your computer in ITunes.

- How long does the blue backlight stay on for?

20 seconds after last button press, the backlight turns off. 5 minutes after last button press, the
remote goes into sleep mode. Press any button to wake It up.

- Strange colors and patterns are appearing on my computer’s monitor and | don’t know
why.
Make sure that the Video Mode setting is set to Hidden so as not to display the iTunes Visualizer.

- | have a video podcast in my playlist. How can | view it?

Videos should normally be displayed within the main iTunes window, unless you have opened up
another window in which to view them. However, if the iTunes Visualizer is on, only audio will be
heard, so tum off the Visualizer if you want fo see the video.



- How can | reach fast a music track located far in the list from the currently loaded track?

Use the accelerated navigation, by pressing and holding the Menu button while tuming the scroll
wheel 10 “jump fast ™ through the playlist,

- How can | open another playlist when | have started with ene playlist?

By pressing the Menu buttion, comme backward to the first menu on the remote, select the heading
"Playlsts” and chose the new playlist.”

- Can | use rechargeable AAA batteries to power Tunes Explorer Wireless?

Yes, but the operating time can vary depending on the rechargeable batteries used. For
rechargeable battenes, we recommend Nickel Metal Hydnde (Ni-MH),

Copyright

Hercules® is a registered trademark of Guillemaot Corporation S.A. Intel and Pentium® are registerad
trademarks of Intel Corporation. AMD Athlon & & trademark of AMD. Microsoft® Windows® XP is a
regestered tradernark of Microsoft Corporation in the United States and'or other countries. Apple®, Mac
CEE, iPod®, iTunes® and CuickTime® are registered trademarks of &pple Compuier, Inc.  All ciher
frademarks and brand names are hereby acknowledged and are property of their respective owners.
llustrations not binding.

FCC Warming

Changes or modifications not expressly aporoved by the parly responsible for compliance could void the
user's authorify to operale the equipment or modifications not expressly approved by the parly
responsible  for compliance could woid the users authorly to operale the equipment

Mote: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules, These limits are designed 1o provide reasonable prolaction against
harmful interference in a residential installation. This equipment generates, uses and can radiasle radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interferance wall not accur in a
particular installation. If this equipment does cause harmful interference to radio or television recephon,

which can be determined by turning the equipment off and on, the user is encouraged to try to comect the
interiarance by one or more of the following measuras:

—Reorient or redocate the receiving antenna.

—Increass the separation between the eguipment and receiver.

—Connect the equipment into an authet an a circut different from that to which the receer is
conneched,

=Consult  the dealer or an  experienced radioTV  technician  for  help.

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.



6. TECHNICAL SUPPORT

If you encounter a problem with your product, please go to http:/ts.hercules.com and select your
language. From there you will be able to access various utilities (Frequently Asked Questions (FAQ), the
latest versions of drivers and software) that may help to resolve your problem. If the problem persists,
you can contact the Hercules products technical support service (“Technical Support”):

By email:
In order to take advantage of technical support by email, you must first register online. The information

you provide will help the agents to resolve your problem more quickly.

Click Registration on the left-hand side of the Technical Support page and follow the on-screen
instructions.

If you have already registered, fill in the Username and Password fields and then click Login.

By telephone:

United 1-866-889-5036 Monday to Friday from 7am to 11am and from Noon
States Free to Spm

Saturday and Sunday from 7am to Noon

(Eastern Standard Time)

Denmark 80887690 Monday to Friday from 1pm to 5pm and 6pm to 11pm
Free (English)
Saturday from 9am to 1pm and 2pm to 8pm
Sunday from 10am to 1pm and 2pm to 5pm

Finland 0800 913060 Monday to Friday from 2pm to 6pm and 7pm to
Free Midnight (English)
Saturday from 10am to 2pm and 3pm to 9pm
Sunday from 11am to 2pm and 3pm to 6pm



7. WARRANTY

Worldwide, Guillemot Corporation S.A. (*Guillemot”) wamrants to the consumer that this Hercules
product will be free from matenal defects and manufacturing flaws for a period of two (2) years
from the original date of purchase. Should the product appear to be defective during the warranty
period, immediately contact Technical Support, who will indicate the procedure to follow. If the
defect is confirmed, the product must be retumed 1o its place of purchase (or any other locaton
indicated by Technical Support).

Within the context of this warranty, the consumers defective product will, at Technical Support's
ophon, be either repaired or replaced. Where authorized by applicable law, the full liability of
Guillemot and its subsidiaries (including for indirect damages) is limited to the repair or
replacement of the Hercules product. The consumers legal rights with respect 1o legislation
applicable o the sale of consumer goods are not affecled by this warranty.

This warranty shall not apply: (1) if the product has been modified, opened, altered, or has suffered
darnage as a result of inappropriate or abusive use, negiiQEnm. an accident, normal wear, or any
other cause nol related to a material defect or manufacturing flaw; (2) in the event of failure to
comply with the instructions provided by Technical Support; (3) to software not published by
Guillemot, said software being subject to a specific warranty provided by its publisher,

ENVIRONMENTAL PROTECTION RECOMMENDATION

Al the end of its working life, this product should not be disposed of
with standard household waste, but rather dropped off at a collection
point for the disposal of Waste Electrical and Electronic Equipment
(WEEE) for recycling.
This is confirmed by the symbol found on the product, user manual or
packaging.
Depending on their characterstics, the materials may be recycled.
Through recycling and other forms of processing Waste Electrical and

B Gectonic Equipment, you can make a significant contribution
towards helping to protect the environment.

Please contact your local authorities for information on the collection point nearest you.



